0.0 - New in version 2.0

FontBuddy 2 is a new version of FontBuddy. It was almost completely rewritten. There are many new features
and improvements, including:
* New user interface
o New [Font Browser to view and print uninstalled fonts
o New “Font Inspector” to track duplicate fonts
« Better font Information
» Font Selector, to enter font name with keyboard.
__* New online help
o Redesigned “Characters” and “Selector” Tabs
e Support for all MacOS keyboards
» Support _for Japanese 2-byte fonts, including CID PostScript fonts
o Support for ATM Deluxe/Suitcase
o Full support for drag and drop
* Japanese and French versions
e Localized printout in 10 languages
o And much more...

1.0 - Overview

FontBuddly 2 is a Font Viewer.

It shows alll the characters of any font.

It provides the keystroke(s), ASCII and Unicade for any character.

Any character can be coplied for pasting into word processors or other applications. Meakes it easy to use
those hard-to-find special characters

FontBuddy 2 can print samples of both installed and uninstalled fonts.

It is easy to use and MacOS 9 savvy.

2.0 - FontBuddy Tabs

2.1 - Characters Tab

In the Characters Tab, you can see all the characters in the selected font. You cam drag and drop any
character ffrom the grid to the Character Pasteboard or to any open window (including Finder desktop) supporting

drag and drop.

If you double-click on & character or type a character on the keyboard, FontBuddy will shift to the Selector
Tab, display the character and information about it as described in the Selector Tab section.

When a Japanese font is selected, a First byte popup menu appears. It allows to view the extra 2-byte characters
of the font.

2.2 - Selector Tab

In the Selector Tab. vou can browse through characters, one by one. For each character, you get its
ASCIl/Octal/Hex/Unicode code, its PostScript name, and the keystroke(s) fo get it.

To select a character, just type it on the keyboard, You can also select iits ASCI| code with the scroll bar or enter it
in the ASCIl/Octal/Hex/Unicode field.

Finally, you can drag the character to Character Pasteboard or to any open windows (including Finder
desktop) supporting drag and drop.

Tips: FontBuddy uses the current system keyboard (resources) to display keystrokes. If you change your

system keyboard while using FontBuddy, the keystrokes won’t be updated until you switch to another tab.

2.3 - Sample Tab

The Sample Tab displays a sample text in the current font. The sample text used depends on the current keyboard.
There are localized sample texts for Danish, English, Finnish, French, German, ltalian, Japanese, Norwegian,
Spanish and Swedish keyboards.
You can change the sample text, but your changes won'’t be saved, unless you change FontBuddy preferences



(see below).

Tips: [f you change your system keyboard while using FontBuddy, the sample text won’t be updated umnfil
you switch to another tab,

2.4 - [nformation Tab

The Information Tab provides information about the selected font (PostScript name, bitmap sizes, Copyright, ...)
including information about duplicate fonts. Be aware that FontBuddy is quite picky with duplicate fonts,
mostly with duplicate bitmap fonts. You may ignore its warnings.

3.0 - Printing

FontBuddy has four ways to print font samples:

8.1 - Printing the current font

To print a sample page of the current font (the font you see in the FontBuddy main window), select Print One from
the [File menu.

In the dialog box that appears after you select this option, you can select either a Text Sample_or a Character Table
printout:

_ Text Sample provides a sample page with a full set of characters and the sample text from the Sample Tab in
three diffferent sizes, 10 points, 12 points, and a third selectable larger size.

o Character Table provides a table showing each character in a set and its corresponding keystroke(s).

Clicking the disclosure triangle shows the printing preferences:

s Head Font is the font used for headers (Title, Font Name, ...)

s Largest Text Size is the size of the third sample text printed.

_» Sample Text popup menu lets you choose the sample text used in the printout. Default uses the sample text
corresponding to the current keyboard. Currently, sample texts for Danish. English, Finnish, French, German,
ltalian. Japanese, Norwegian, Spanish and Swedish are available

o Language popup menu lets you choose the language used in the printout. Default uses the application
language. Currently, Danish, Dutch, English, Finnish, French, German, Italian, Japanese, Norwegian, Spanish and

Swedish languages are available.
_ You can also set the layout of the character table (in case you select a Character Table Layout): check Keystroke

if you want FontBuddy to print under each character the keystroke(s) that produce(s) it. Check Grid if vou want
FontBuddy to print the Grid of the table.

3.2 - Printing several fonts at once

To print several fonts at once (using the same layout as Print One), select Print Several from the File menu.

In the dialog box that appears after you select this option, check each font you want to print. By double-clicking on
each checked font, you can specify either a “Text Sample” or “Character Table” printout and extra styles to print.

Clickinag the disclosure triangle shows the printing preferences, See Print One, above, for more information.

Warning: If you get a VMERROR when printing to a PostScript printer, try to check “Unlimited
Downloadable Fonts” in the PostScript Options of the FontBuddy Page Setup.

3.3 - Printing index
To print an index of several fonts, select Print Index firom the File menu.

In the dialog box that appears after you select this opticn, check each ffont you want to add to the index. If
you double-click on a font name in the [ist, yvou can specify extra styles to include in the index.

Eor each font, FontBuddy prints its name, and several sample lines. default, the ffirst line consists of the
string “AaBbCcDd...” and the second of the string “0123456...".




Clicking the disclosure triangle shows the printing preferences:
o Head Font is the font used for title and font name.

* Number of Columns_let you select the nhumber of columns of the printout.

s Sample Font Size is the font size of the sample text.

o Language popup menu lets you choose the language used in the printout. Default uses the application
language. Currently, Danish, Dutch, English, Einnish, Erench, German, ltalian, Japanese, Norwegian, Spamnish
and Swedish languages available.

* Sample Text contains one or several lines that will be print for each font. Each line will be cut to fit in the
column.

Warning: If you get a VMERROR when printing to a PostScript printer, try to check “Unlimited Downloadable
Fonts™ in the PostScript Options of the FontBuddy Page Setup.
3.4 - Printing uninstalled fonts

The only way fto print uninstalled fonts, is to open them in the Font Browser, See the Font Browser section below
for more information.

4.0 - Font Browser

The Font Browser allows you to preview and print uninstalled fonts (i.e., fonts that are not installed in your

Font folder).
To open the Font Browser, select Font Browser {rom the Window menu or use the shortecut Command-E.

__Tips: You may also drag and drop a suitcase or a folder on FontBuddy’s application icon. It will be opened
in the Font Browser!

Click Add fonts... to select a folder which will be explored: each font suitcase in the selected folder (and its
subfolders) will be added to the Font Browser list. If you option-click Add Fonts..., it will clear the suitcase list
before adding new ones.

Select any font suitcase in the list to preview its content. You can also “expand” the font suitcase, and select
fonts one by one.

Tips: When previewing individual fonts in a suitcase, FontBrowser also gives the Font Information.

To print an index, click on Print Index... button. See “Printing Index” Section for explanations for the Printing dialog.

ning:_You may need to increase FontBuddy memory allocation when printing large collection of uninstalled
fonts. Also. you may improve printing performance by selecting “Black and White” output in the printing dialog.

__Tips: You can also load one or several suitcases in FontBuddy, by selecting Add Fonts... or Add Folder... in

FontslOther Fonts menu in FontBuddy main menu. The new fonts will be added to the Font/Other Fonts
submenu.

5,0 - Font Inspector

With the Font Inspector, vou can search for duplicate fonts installed in vour Fonts System Folder (or activated
by ATV Deluxe or Sultcase).

To open the Fomnt Inspector, select Font Inspector from the Window menu. When you click Start, FontBuddy will
analyze the fonts installed in your System, searching for duplicate Bitmap, TrueType or PostScript fonts. It will also
report Screen-Only Fonts (fonts without TrueType or PostScript Outlines). The result of its job will be displayed in the
lower part of the window.

6.0 - Character Pasteboard



The Character Pasteboard helps vou to store characters when browsing vour fonts.

To open the Character Pasteboard, select Character Pasteboard from the Window_menu. The floating window can

store any character of any font. You can drag a character from FontBuddy main window or enter it directly from
keyboard.

Tips: The current font of Character Pasteboard is the same as the main window, but the current size, is the size of
the Characters_Tab.

7.0 - Preferences

To change [FontBuddy’s preferences, select Preferences... from the Edit menu. In the dialog box that appears
after you select this option, you can change the behavior of FontBuddy:

___o Show control characters: when checked, the Characters Tab will show all 256 ASCII characters of a font.
Otherwise, the control characters (ASCII 0 to 31) are not displayed.

o Enable auto-sized font in “Characters”: when checked, FontBuddy will try to select the best font size to show all
the characters of a font in the Character Tab.

* Remember windows® positions: when checked, FontBudlcdy will save the windows’ sizes and posfitions.
o Remember font and sizes: when checked, FontBuddy will save the current font and sizes at quit.

* Save Pasteboard’s Contents to Clipboard: when checked, the content of the Character Pasteboard is
saved fo the clipboard when switching to another application or when quitting FontBuddy.

o Use Navigation Services: when checked, Open/Save dialogs will use Mac OS 8.5's Navigation Services. In some
case, it may crash FontBuddy.

« Save changes to sample text: when checked, FontBuddy will save the changes you make to the sample text.
Be aware that FontBuddy stores one sample text for each keyboard you use.

o Sample Text popup menu lets you chaose the sample text used in the Sample Tab. Default uses the sample
text corresponding to the current keyboard. Currently, sample texts for Danish, English, Finnish, French, German,
Italian, Japanese, Norwegian, Spanish and Swedish are available.

Then, click Save to save your changes, or click Default to revert to FontBuddy built-in default preferences
(including FontBuddy default sample texts).

8.0 - Keyboard Shortcuts

Use Command + or Command - to select the next or the previous font.

Use Option-Command + or Option-Command - to select the next larger or next smaller font size.
Use Shift-Option-Command + or Shift-Option-Command -_to increase or decrease the font size by 1 point.

In the Selector Tabs
Use Opt-RightArrow or Opt-LeftArrow to select the next or the previous character.
Use Opt-UpArrow or Opt-DownArrow fo select the first or last character (ASCII 0 or ASCII 255),

In the Characters and Sellector Tabs, any character typed on the keyboard will be shown, with its information, in the
Selector Tab.

Tips: The “+” and “-” keys must be typed in the numeric pad.

Comments: FontBuddy L.x shortcuts are still availables
se Cirl-Tab or Ctrl-Shift-Tab to switch to the next or the previous tab.
se Ctrl-LeftArrow or Ctrl-RightArrow fo select the previous or the next font.
se Curl-UpAmrow ar Ctrl-DownArrow fo select the next larger or next smaller font size.
__se Ctrl-Shift-DownArrow or Ctri-Shift-UpArrow to decrease or increase the font size by 1 point.




9.0 - Version History

Version 2.0 [2000/05/30] Final release

Version 2.0.1 [2000/06/19)] Final Japanese release. Improves Kaleidoscope compatibility. Other small bug fixes.

Version 2,0.2 [2000/11/04] Fix a major bug in FontBrowser which may. in some cases. corrupt the opened fonts. FEix
a small bug in Font [nspector. Add support for Norwegian (Sample text and printout). Eix Swedish printout. Other

small bug fixes.

Version 2.1 [2001/01/04] Improved FontBrowser: it will now correctly preview any uninstalled font; it does not
flicker anymore; printing Index of uninstalled fonts requires much less memory and generates smaller
spool/PostScript files; add font information (PS name, ...) when previewing individual fonts; remember
preview size. Add a FontList floating window that...lists all the installed fonts. Add support for OpenType font
(Font Information). Fix a “Out of memory” bug when selecting “Information” tab on some systems. Add page
number to indexes. User can drag and drop disk and floppy (but also folder) on FontBuddy application icon:
FontBuddy will open the fonts found inside the drag item in the FontBrowser.

Version 2.1.1 [2001/01/25] Fix a bug that prevents FontBuddy to correctly print keystoke when Chicago is
used as the default system font. FontBuddy can open individual font files (fonts outside font suitcases).

10.0 - Registration

FontBuddy 2 is distributed as Shareware. You can try it for one month. If you want to continue to use it, you should
pay the shareware fee : a License for a single user costs $20, a Site License costs $100, a WorldWide License costs
$200.

Registered users of FontBuddy 1.x can upgrade to FontBuddy 2 for $1.0 ($50 for a site License).

After you've registered, you'll get a registration code that will remove all limitations.

You can pay with KAGI registration system: open the Reqgister program that accompanies FontBuddy. then follow the
instructions. You can also reqgister online at https/lorder.kagi,com/?U25&S

9.0 = Contact

You can contact the author by email at vjalby@kagi.com . To find the latest version of FontBuddy 2, go to
http://members.aol.com/vjalby/

12.0 - Thanks

I want to thank all beta testers and users for their suggestions and bug reports. Among others, Mark Handler, Steve
Evans, Andy Findley, Mark Leinwand, Mark E. Bremmer and Pleter Coolsmea who helped me to improve

FontBuddy 2.

Yoshi Sakuma was the translator of the Japanese version. He also helped me to understand Japanese Fonts and fo
improve 2byte fonts support in FontBuddy 2. Thank you very much Yoshil

Localizations of printout were done with the help of Peter Thorn (Danish), Pieter Coolsma (Dutch), Harri 3J
Nuppola (Finnish), Peter Weber (German), Gianluca Macelloni (Italian), Yoshi Sakuma (Japanese), Bjgrk
Eliassen (Norwegian), Abel Crespo (Spanish), Axel Henriksson and Kristina Palm (Swedlish). Thank you &ll
very muchl

Thanks also to all the registered users.

13.0 - Background on Fonts (For advanced users!)

--------- Very first draft ---------



In this section, | will try to describe how fonts work on the Macintosh. The first paragraphs are quite simple, but the
last ones are more technical, and should be read by advanced users only .

| try to be as precise as possible, but in some parts, | may slightly simplify the reality.

13.1 - Bitmap, TrueType and PostScript fonts

There are three kinds of fonts available on the Macintosh: Bitmap, TrueType and PostScript:

__o Bitmap fonts: these fonts, also called Screen fonts, are bitmap pictures of each characters of a font at a
specific size. Typically, they are available at 10 and 12 points.

They are stored in font suitcases (a folder with a big blue A). When you open such a suitcase, you can see the
list of all the sizes and styles available. Each bitmap font has a generic document icon with a big blue A.

These fonts are specially designed for screen use at a specific size. If you try to use a bitmap font at a size not
available, then you get a sloppy preview. Also, using bitmap fonts for printing will give very bad printout.

Example: “Times 12" is the bitmap font Times at 12 points. “Times (Italic) 9 is the bitmap font Times at 9
points with italic style.

o TueType fonts: They are scalable fonts. They can be used at any sizes, on screen or when printing. Actually, a
TrueType font contains the mathematical description of the outline of each character of the font. Using mathematical
formula, this description is used to draw the char at any size or when printing.

The TrueType fonts live inside the same suitcase as Bitmap fonts. Inside the suitcase, the TrueType font
has an icon with several big blue A.

The name of a TrueType font is the same as the Bitmap font, without the size number.

Example: “Times” or “Times (Bold)” are TrueType fonts for Times and Times-Bold.

o [PosiSerpt fonts: They are also called Type 1 fonts or Outline fonts. They are scalable fonts too. They can be
used at any sizes, on screen or when printing, but they requires the Control Panel Adobe Type Manager (ATM).

In general, a PostScript font has a red icon with a big A. You cannot open them, nor put them into a font suitcase.

Example: “TimesRom” is a PostScript Font for “Times (Roman)”.

Comments: Mac OS don't know anything about PostScript font. Thus, any PostScript font comes with a Bitmap
Font. And it's the job of ATM (or of the Printer Driver) to link the Bitmap Font to the PostScript Font (file).

13.2 - [Font Sultcase
FontSuitcases are “folders” that can store Bitmap or TrueType fonts, However, they cannot store PostSecript font file.

In general, it's a good idea to always keep Bitmap and TrueType fiont in a suitcase, [deally, & font suitcase should
contain all the Bitmap and TrueType fonts available for a font Eamfly.

E : The Mac OS “Times” font suicase contains all the TrueType fonts (“Times”, “Times (Bold)”, “Times
(ltalic)”, “Times (Bold, ltalic)”) and Bitmap fonts (“Times 9", “Times 107,..., “Times 24") for the font family Times.

13.3 - Use of font on screen

When you use a font in an application, Mac OS will first check if there is a bitmap font available at the size
you request. If yes, this one will be used. Otherwise, it will use the TrueType font. If it can find a TrueType
font for that font, and if ATM is installed, then it will use the PostScript font. And if there is no PostScript font
for that font, Mac OS will scale one existing bitmap font to the request size. Most of the time, the result is
quite bad.

Comments: That means, even if you install both TrueType and PostScript version of the same font, the
PostScript font will be never used on screen.

However, if you've checked the option “Smooth all fonts on screen” in Mac OS 8.5 Appearance Control Panel, then all
sizes greater than 12 (or whatever size you enter in Appearance) will be drawn using the TrueType fonts.

The same occurs with PostScript fonts (that do not exist as TrueType), if you check the option *“Smooth Font Edges
on Screen” in ATM 4.x Control Panel,



o for all sizes if you don't check “Disable Smoofhing at Screen Font Point Sizes™
__ -« for all sizes but the ones available as Bitmap fonts, otherwise.

Comments: All this also applies when printing to a QuickDraw (non PostScript) printer.

13.4 - Use of font when printing

When Printing to a PostScript printer, Mac OS behaviour is slightly differents: it first check if there is a
PostScript version of the requested font. If yes, it is used. Otherwise, it will use the TrueType fonts. And if
there is no TrueType font for that font, it will scale one existing bitmap font to the request size, producing
uglly result. Somefimes, the Printer may also substitute a default font (*Courfer”) to the bitmap font.

13.5 - Styles

When you select a style (Italic, Bold, Underline, Condenseds....) in an application, Mac OS will check if there
exists a bitmap font with this style (e.qg. “Times (talic) 9”). If ves. it will use it, Otherwise, and if there is no TrueType
font with that style, it will modified the base font with the style you request (e.q. ltalic will produce slant font).

The same occurs with TrueType font (e.q. “Times (ltalic)” TiueType font will be used).

Einelly, PostScript font follows the same behaviour, even [f style PostScript font have very different name
(e.aL, [talic version of “TimesRom?” fs “Timeslia” and not “TimesRom (ltalic)”).

Comments:_Even if you can always see the request style on screen, be aware that not all styles exists for all fonts.
When printing, you can get unexpected result. For example, you will never get bold “Symbol” when printing, even if
you can see it on screen.

13.6 - Font name

The font name you can see in an application Font menu, is always the name of the Bitmap (or TrueType) font
(without the size number). Since the TrueType and Bitmap fonts use the same name, the situation is quite
simple.

Comments: Since each PestScript font comes with an associated Bitmap font, the situation is the same for
PostScript font. But, let us recall that Mac ©S does not directly use [PostScript fonts. Se iif you install @
PostScript fomnt, without fts Bitmap font, you won't see it in your application’s Fomnt menu. Also, if you install
the same font as TrueType and Bitmap/PeostScript font (but you shouldn’t), i will appear only once in your
Fomt Menu. Depending you are using thet font on screen or when printng, Mac OS  (and ATM) will use the
TrueType or the PostScrpt version of that font.

Other Comments: If a font name start with “.”or “%”, then you won't see it in your Font menu. Such font are for
internal use, and you don’t have to worry about it.

Example: “%MAdobeSanMM_50 50" is a special font used by Acrobat to display missing fonts.

13.7 - PostScript Font name

Actually, the font name you see in your FontMenu is not widely used. Several softwares (ATM, Printer Driver,

Adobe lllustrator,...) use the PostScript Font name. It's an extended name of the font, which should be
unique. Each font and style has it’s own PostScript name. That name is stored in the Bitmap or TrueType
font, even if you cannot see it. (But that’s why you are using FontBuddy Information, isn’t it?)

Example: PostScript [Font name for “Times” and “Helvetica (Bold, alic)” are “Times-Romamn” and
“Hellvetica-BoldObligue™.

s: The PostScript Font name (e.g. “Helvetica-BoldOblique”) is also used to get the name of the
PostScript Font file, using the 5-3-3 rules: the first word (here, “Helvetica”) is reduced to its five first letters
(here, “Helve™), and the next words (here, “Bold” and “Oblique™) are reduced to the first three letters (here,
“Bol” and “Obl"”). The name of the PostScript font file is then obtained by concatenation of all reduced words
(here, “HelveBolObl”).

13.8 - The key of fonts: the FOND resource (Very advanced users!)

All the stuff described above are gather in one system resource called FOND. You cannot see this resource, but it



lives in each font suitcase you used. Actually, there is a FOND resource for each font “family” in a suitcase (whenever
they are Bitmap or TrueType fonts).

The FOND resource contains the name of the font, i.e. the name you will see in the Font menu of your applications. It

also contains the list of all sizes and styles and TrueType version available (in the suitcase) for this family. Most of the

time, it also contains the full PostScript name of the font and its styles. Finally, it contains the char dimensions,
kerning,...

When you select a font, Mac OS will look in the FOND resource with the same name, and will try to find inside the
bitmap size, TrueType or PostScript Font name you request.

__Comments: If you install several suitcases with fonts (Bitmap or TrueType) from the same family (e.g., one suitcase
with TrueType font “Times” and another with Bitmap font “Times®), then there will be several FOND for the same
family (here “Times~). It’s very hard to predict what will happen. Mast of time, if the dimensions, kerning are the same
everything should work as expected. But if dimensions or kerning differ, problems may begin.

Other comments: FOND resources are also used by Mac OS to get the full PostScript name of the font (and
related styles). In the case of a PostScript font, ATM and PostScript Printer will used
that name to show or print that font. Again, if there are different FOND resource for the same font family, ATM
or PostScript printer may fail to find the good font.

14.0 - Legal Stuff

Use this software, FontBuddy 2, at your own risk. The author, Vincent Jalby, makes no claims as to the fitness of this
software, FontBuddy 2, for any particular purpose. There are no warranties, expressed or implied.

This application was built using REALbasic 2 from REAL Software, Inc. For more information, check out
http://www.realsoftware.com/.

FontBuddy 2 uses:

o DivineFSplug, Copyright ©2000 William J. Lemke. All Rights Reserved.

o Micomo RbStringUtil, NewPicture, Copyright 1999, Micono Utilities. All rights reserved.
__ s Filelcon Plugin, © Doug Holton.

¢ TT's FileMgr Plugin, © Thomas Tempelmann.
___¢ App-Plugin, © 1999 by Helge Herrgeselll, Digitalis OEG .

° PG _RBStandardAlert, © Michael Herzog, 1999 PERGAON interactive visual desigmn

REALDbasic is a registered trademark of REAL Software, Inc.

ATM, Adobe lllustrator, PostScript are trademarks of Adobe Systems.
Suitcase is a trademark of Extensis.

Apple, Mac OS, TrueType are trademarks of Apple Computer, Inc.




